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User’s Guide Written by

Oregon OnePlan Version 1.00.02 User’s Guide was modified from Idaho’s User Guide.  

It was edited and updated from Idaho’s version by 
Jennifer Zwicke  

Environmental Engineer
Natural Resource Conservation Service
Introduction

Version 1.00.02 of Oregon’s OnePlan Nutrient Management Software is now available for development of CNMPs and for preparation of Field Annual Nutrient Budgets. We have modified Idaho’s OnePlan Nutrient Management Planner (NMP) for use in Oregon
Oregon OnePlan is an extremely complex program that makes use of the latest technology in the development of plans. The mapping program takes advantage of the GIS information that has been collected by various agencies. Users access the map via the Internet. Once the farm map data is located, it must be “clipped” and saved as a file, which is then accessed by the software. When the data is “clipped” and saved, several layers of GIS data are also saved, such as FSA CLUs, soil types and soil data, resource concerns, stream and waterway data, soil slopes, field maps, climatic data, HUC information, stream listing information, buildings, corrals and other features.  

Oregon OnePlan NMP is designed for planners and will continue to be an evolving tool.  As new technologies become available, our technical personnel will continue to look at programming in an attempt to streamline this highly sophisticated, technical piece of software. As with previous version many countless hours have been spend by our technical experts and software programmers in trying to improve the performance and accuracy of the data utilized in the program. We ask you continue in offering areas and items for ongoing improvements, we ask you to be patient as we work together, through the challenges that may accompany using such a complex program, to improve the performance and quality of the finished product. Again, if users can document problems or suggest improvements and forward those to the design team, these suggestions will be taken into consideration.  If you encounter major glitches in the program, please contact, NRCS Oregon Environmental Engineer @ 503-414-3231 or Jennifer.zwicke@or.usda.gov. 
As with any program, the output is no better than the information that is provided to the program. The AFO Inventory Form found on the Oregon NRCS Environmental Engineering website provides an excellent start in the collection of the appropriate information. There is no substitute for personally involving the producers in the process of development of the plans; they are “their” plans.  Discussing the input with the producers as the information is being entered will help eliminate miscommunication that might otherwise occur.
General Operating Information

Many of the features of Windows programs are also a part of the OnePlan Nutrient Management Software. The program is designed to operate on Windows 2000 and Windows XP.

Initial Start-up
The program upon initial startup following installation has a default setting for (security reasons) for saving the farm NMPs files in the:
C:\Documents and Settings\your.name\Application Data\OnePlan folder.  This default setting can be changed on install or it can be changed within the program by editing the “Edit preference” tab to C:\OnePlan folder for future NMP file storage.  If two users use the same machine, you will need to change the default file path to remove the users name from path name.
Progressing Through the Program
The best practice is to follow the path provided by the program, as it will request information in the order in which it is needed, however the program is stable allowing the user to move from one screen to another without interfering with operation of the program. Upon completion of data entry into a cell or blank, the data is automatically being stored into the appropriate database when the “next” button is pressed moving the user to the next input screen. When revising existing data, it is essential that the “next” button always be pressed to save the data and to initiate recalculations made by the program. There is no action required by the user to insure that information is stored except to leave the completed cell. (There are a few exceptions; data is stored by pressing, “Enter”, “Next” or “Finished.” These instances are fairly obvious as you use the program.)

Unlike many programs, when the software is closed, it remembers where you finished.

When the software is restarted, the program will resume where you ended your last session.  If this ever becomes a problem, please contact NRCS Oregon Environmental Engineer for help in getting off the screen.
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The program is laid out in “Tabs.” 
Each “Tab” contains a different set of information; in much the same manner as a set of “Tabs” or dividers in a notebook is used to divide groups of data into similar categories. When the user completes a section and presses “next” they are automatically moved to the section or “tab” and entered data is saved.  The user can move from tab to tab by placing the cursor on the desired tab and left clicking or by accessing the “Forms Navigation (Ctrl+T)” or by clicking on tab “View”. The tree is similar to the tree found in the directory of Windows programs.  Move through the tree to the desired screen and left click. When an item in the tree is preceded by a “+”, the item has one or more items which are hidden. These hidden items can be displayed by “clicking” the “+”. A list of items that has been opened may be re-closed by “clicking” the “-“, which appears after the list is opened.

Buttons are used as controls in the program. Three buttons that are commonly used are 

“Finished”, “Next”, and “Back”. Many of the sections of the program require the use of the “Finished” button to signal the program that you have completed the active part of the program. Generally, there is information on the screen that will make the purpose for the “Finished” button clear. The “Next” button signals the program to continue to the next screen set to request new information. The “Next” button may provide the next step of loop through similar information (for example, continue from entering data on one animal group to the next of a series of animal groups). The “Next” button may also cause the program to move from one “Tab” to the next “Tab.”

Welcome Page
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The first window opened in OnePlan is the “Welcome Page”.  The planner’s Welcome page has three options: 
1. Downloading a new map file for creation of a new planning unit.
2. Starting a new Farm Nutrient Management Plan using the downloaded data, or 
3. Opening a existing NMP file for completing a partial plan or revisiting and/or updating an existing plan. 
Download Map

Before downloading a map, you will need to change a security setting on your internet browser.  Go to Tools-> Internet Options -> Security -> Trusted Sites -> Sites.  You will need to add the following website to your list of trusted sites: http://maps.informationdesigns.com.  You will also need to unselect the check for “Required server verification” as shown.
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To start a new plan the user must first download a map file and its associated Soils data.  To create the map file for a new plan, click on “Download Map” on the first page of the program. Once this selection has been made the user will be connected to the Internet map server where the opportunity to select the area containing the map will be available. The area can be identified by selecting a location using the legal description (which includes the township, range and section), by giving the GPS location of the property (using latitude and longitude values), by entering the zip code, or by entering the county or town from the dropdown listings. When the map is displayed, select the smallest portion of the map that contains all of the land to be included.  When an appropriate size is selection, the Download button will be activated.  If the Download button is not activated then keep zooming in.  
If there is more cropland than can be included in the 3 square mile map, additional maps downloads will be needed for the additional farms included in the plan.  This capability has not been included in the NRCS CCE version of OnePlan but the version of OnePlan available from the Oregon NRCS Environmental Engineering website (dated after May 26, 2008) does have this capability.
The downloading windows format has specific direction located on the left panel of each downloading window.  By following these instructions the planner can easily navigate through the following sequence in the map downloading process: 
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Once the desired area has been delineated, 
the planner is required to enter a unique
name for the download file in the “download” 
box. Give the file an appropriate name then 
download. The user will be asked to either 

open or save the file, “Save the file”.  
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Unless the planner selects a specific file address for saving the download, the file will be saved where the last download was saved.
Once the Save option is selected the  program then extracts the data from the Map Server. The extracted data is saved as a zipped file on your computer.

New Farm 
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Once the map file is downloaded and saved, the next step will be to develop the new farm.  Since the data downloading is outside the OnePlan model, NMP has to be activated by clicking on the OnePlan icon on the window taskbar or in the area of your computer where minimized programs are shown.  
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If you try to reload the OnePlan module, you will get an error message.   

You are now directed back to the “Welcome Tab”.  By selecting the “New Farm” option, OnePlan NMP will ask the user to locate the downloaded data file for unzipping into a new farm data file. 
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Next, the software will upload the database files from the OnePlan program file and download the data into the new farm database.  The new farm database is stored in the directory specified in the Edit->Preferences folder.  Another project specific file (an OPP file) is store in the C:\Program Files\USDA\ NRCS\OregonNutrientPlanner.  The *.opp file is the link the program uses to load and store data for a particular project.
[image: image30.png]Instructions
Delivery Method
Select ore:
<ot [FELD 2 =
Field & Siphon Tubes

op [P0 Potae BendteT] |- o
CopytisFil | pcres [TT6 | EsienDich

Enter Characteristics
Longest futow or Feldlength | 650 Feet

Futow or border spacing |25 Feet
Time ta reach end of Furion & Hous

Furrowm Flow Rate 7 GPM

Start/End Date:
Ithe Furow || StartDate

Flow Rateis 57172005

Urknown use
EndDate

Flow Estimator | || [10715/2005



At the initiation of the new farm the user 

will be asked to enter the current planning 

year.  This is critical in establishing the 

farm plan’s base year. 
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New Farm: Multiple Downloads

When the farm is larger than the extent of one download screen, then the planner will need to download as many zip files as necessary to represent all the fields of the farm.  Boundaries can overlap or be several miles apart.  After downloading all the necessary zip files in order to represent the enter farm, the user will use the “Merge” function to upload all the zip files.
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Opening Existing File
The third option on the Welcome page is the option to “Opening Existing File”.  This option is used when the planner wants to reopen an existing plan for completion, revision and updating.  Upon selecting the “Open Existing File” an “Open New Farm” window appears.  The window lists all the existing plan .opp links for files that are currently recognized by OnePlan.  
What if I do not see my saved file? 
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If you see the file you want opened simply highly 
and open the file.  If you do not see the file the 
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planner can use the “Catalog Existing Plan” tool by opening the “Tools” tab.  The program will open a new window “Choose Database for OPP Creation”.  The planner is asked to locate the file where the data for the saved NMP was stored (farm.mdb).  The planner will highlight the .mdb file and a window will open stating that plan has been cataloged to the OnePlan file and now can be opened with the “Open Existing Plan” procedure.
Farm Plan / Data Security

Once the planner initiates a farm plan, it is the responsibility of the planner to secure the information being developed because everything is stored on the user’s computer.  The program will store updated data to the farm.mdb file where the plan is cataloged which can be found in the Edit->Preferences menu.  If you move this file or if you happen to update your folder names, you can re-locate this file by going to Tools-> CatalogExisting Plan.  The program will open a new window “Choose Database for OPP Creation”.  The planner is asked to locate the farm.mdb file where the data for the saved NMP was stored.  Once you are finished working on the file, then “Close” the file using the “File” tab. This will insure that the updates of all planners working on the farm plan are properly saved.
Mapping Your Farm

Getting Started
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As previously mentioned, the map data must be “Clipped”, or downloaded from the map source found on the Internet and saved as a file.  The view to the left is an example of the map feature that you will use.  Notice the         tools on the tool bar.  Selecting the         tool         allows the user to zoom in on the map by clicking in the map after the tool is selected. Likewise, selecting the         and clicking in the map will zoom out on the map.  The pan (hand) tool allows the user to move the map in the window. Selecting the tool and then clicking in the map window while dragging in the desired direction results in the movement of the map.  Once the map has been loaded as part of the program file, the first step is to outline the fields.
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On the next page, the planner will need to name the Ranch or Farm.  If the field boundaries for the farm or ranch need to be imported, go to the next section, Import Fields.  If the field boundaries need to be drawn, go to the section Draw Polygons.  Also on this page, is a radio button where the planner designates whether the field is owned by the landowner or not.  The software default is that the field is owned but the planner will need to update this choice if the field is in fact not owned by the producer.
Import Fields
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A great feature is the ability to import FSA CLU digitized field boundaries into the OnePlan Mapping Model.  When the “Mapping your Farm” window is opened, the first action is to give the NMP plan a unique name that will be used as the document farm name title.  Once the farm is named, then the import field window can be opened by clicking the “Import Fields” button.  You are then prompted to “Select a shapefile to import”.  A list of all shapefiles that are associated with the downloaded file is given with the default on the CLU.shp shapefile. Select “Open” to activate the CLU.shp window.  

If you want to load a Toolkit shapefile, you will need to open Toolkit and follow the directions below for Toolkit.

This is a manual procedure to convert a Customer Service Toolkit Planned Land Units layer into a Fields shapefile that can be used in the Oregon Nutrient Management Planner. 

· Start Toolkit, select a customer folder to work with.

· Start a new ArcMap document from the Customer File/ArcGIS_Projects folder, using the Toolkit Template.

· Load the targeted Planned Unit Layer using the Select a Plan tool (“cyberfarmer” icon).
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· Right-click on the data frame and select Data Frame Properties
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Select the Coordinate System tab

· Click the Clear button

· In the Select a coordinate system dialog, 

· Click Predefined
· Click Projected Coordinate Systems
· Click State Systems
· Click NAD 1983 HARN Oregon Statewide Lambert Feet Intl (make sure you choose the one ending in “Intl”)
· Click OK

· Answer Yes to any warnings about coordinate systems.

· Using the Select Features tool, drag a box around the targeted PLU to select all the features.

· Right-click on the PLU layer name in the Table of Contents

· Select Data, Export Data
· In the Export Data dialog

· select the radio button for “the data frame”
· Use the browse tool (yellow folder icon) to open the Saving Data dialog, and choose the location and filename where you want to store the new Fields shapefile.

· Click Save.
· Click OK.
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· Close the ArcMap document but Do Not Save it.

The shape file can be added using the Import Fields button in the Oregon Nutrient Management Planner.
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The “Farm Map” will open showing all the FSA CLU field boundaries.  You can select the fields you want imported into the plan by clicking on them.  They will turn green indicating the field has been selection.  

Following the import, the FSA field boundaries are mapped into the “Map Your Farm” map.  The fields are mapped using default field names from the CLU layer.  The planner may need to rename the fields to fit the growers plan.  It is best not to bring in the shape that represents headquarters facilities with all the structures, etc.  If the shape for the headquarters is added as a field then the software will try to assign nutrients to that field.  When done selecting fields, close the window by clicking the red X in the top right corner of the selection window.
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In order to advance to the next screen make sure that all polygons have black boundary lines.  If a polygon is showing with the polygon vertices highlighted then click the “Next Field” button to save the polygon. 
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Drawing Polygons
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Note that each corner or turn in the boundary must be clicked. Note that the points that are clicked can be modified or edited by left clicking on the point and dragging the point to the new location.  Notice that the area of the field as outlined is calculated and reported in acres. The calculated acreage cannot be over-ridden. Remember that features such as rock outcrops will be automatically subtracted from the acreages when they are identified on the map. 

Crop/Irrigation/Dryland
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The item that is displayed in the “Crop/Irrigation/ Dryland” drop down will be applied to every field that is imported.  The planner will have to update the “Crop/Irrigation/Dryland” for EVERY field in the Field Name drop down to the correct designation.   If the fields are being drawn using the polygon tool, the planner will also have to make the appropriate selection in the “Crop/Irrigation/Dryland” for every polygon.
Distance to Waterway
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Enter the distance to the nearest downstream waterway.  Distance is entered in feet. If this field is left blank the program assumes the worst case scenario and assumes the field discharges directly into a water body. When finished, press the “Next Field” button, which will give the user the opportunity to trace a new field. The user will repeat the process until the distance to the stream has been entered for EVERY field. When all of the fields have been entered, press the “Finished” button and then the “Next” button to proceed to the next “Tab” or part of the program.
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Irrigation / Hydrological

The next phase of the Mapping Features sequence is to map Irrigation and Hydrologic features. When a feature is selected, the appropriate drawing tool (point, polygon, line) is activated for the user to identify the selected feature.  If a feature needs to be associated with a particular field then select the button “Assign this feature to one or more fields”.  The tools along the top of the map can be used for zooming, etc or the “Zoom To” drop down can be used.  When all features have been drawn, press the “Next” button to move to the next screen. 
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Other Field Features
The next screen allows the user to map “Other Field Features”. The planner can draw the feature on the field using the mapping tool (point, polygon, line) chosen by the user.  When finished and can quit by clicking “Finished” and select a different feature.  The user can press the “Add an Outcrop” button to add additional rock outcrops to the field or may select another field to add an outcrop.
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Other Farm Features
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Mapping other farm features is very similar to other mapping field features. Simply select the feature you wish to include and a window that identifies the feature will appear. You will have the opportunity to add an additional feature such as the “Add a Barn” as seen at the left or you may Press “Finished” and return to select another feature or to continue. You can select the appropriate drawing tool for the feature you are entering.  Lagoons are found under the category of liquid manure handling. Solid manure and feed storage are found under storage areas or facilities.  Fields or labels for digitized labels can be moved once they are digitized. The program will frequently lay one label over the top of another making it impossible to read unless it is moved.

Editing Fields and Features

To delete a field: select the field polygon or field feature to be deleted and hit the delete key on your keyboard. 
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To delete a digitized feature: Go the screen where the feature was originally digitized.  Click on, or select the feature that will be deleted to activate the dropdown box. Activate the “Pointer”      tool on the tool bar.   Left click on the feature to be edited to make it active, press delete.

To move the label for a digitized feature. Go the screen where the feature was originally
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digitized. Click on, or select the feature to be edited. Click on the “Pointer”     tool on the tool bar. Move the cursor to the feature that will be edited and left click to make it active. Move the cursor to the location where the label is to be moved to and right click. The label will be moved and a line drawn from the label to the feature to associate it.
Field Conservation Practices
Select ALL the Conservation Practice that applies to your farming practices. The Conservation Practices are grouped by: Cropland Practices, Irrigation Practices, Livestock/Grazing Practices, Water Management Practices, or Water Quality Practice.  After selecting a practice, select the field(s) for which the practice applies.  The software keeps track of the practices and prompts users for pertinent information regarding those practices later in the software.
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Assigning Watersheds
The watershed or HUC, including the HUC Unit number, is automatically populated in the cells. The soil conservation district is also placed in the file. The user is asked to select the climate station. The appropriate climate station or a station that most closely resembles the amount of precipitation at the facility location should be selected.

Nutrient Management Module - Introduction
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“Who Needs a Certified Plan?” button at the lower left hand corner of the screen will provide a brief overview for the user to help them determine if they do, in fact, need to develop a plan.

Getting Started (Commercial Fertilizer or Biosolids)
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The Nutrient Management Module contains the necessary screens to collect information regarding nutrient management on the farm.
NMP for Commercial Fertilizers

Nutrient Management can include animal waste management as well as commercial fertilizer management.  If only working with commercial fertilizers, then the planner will check the “I produce crops and/or have pasture(s)” option.  This will cause the software to by-pass the Animal Waste tabs in the model and take the planner to the cropping “Crops” tab.  
NMP for Animal Waste
[image: image57.png]Enter sol est resuls for every Fiel tested. Start by selecting a Field
from the ciop down men below and then enter the test dae.

Field hoies  Datoof Test
FED T el

LT —
Nest, enter the Soil Data from the test result G
boves o the g

Note: Ciick the "Facts" Buon for a Nuten t see cettain
lmitations orspecal equiements.

[ ottt



For most operations that have animals, all the boxes on the Getting Started page will be selected.  Once the situation has been defined by selecting the appropriate responses in the check boxes as displayed in the screen to the right, the software will guide the user through a series of screens to collect the necessary information for completing a CNMP. The “Tabs” in this part of the software will require input for livestock, bio-nutrients, sizing, crops, irrigation, resource concerns, application and nutrient risks, depending on the situation for each farm.

List of Items Required to Complete a Plan
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The introductory window for the nutrient management module has a button that when pressed will display a list of items that a producer or planner will need to have to complete a plan.  The list can be viewed on the screen or it may be printed for reference.

livestock
Livestock units or manure production units are those groups of animals that contribute manure to the total amount of nutrients applied to the farm or exported to other farms. The different groups of animals contributing manure must be identified individually by adding a row of data.  To  add a livestock unit move the cursor to the grayed area of the Livestock Units page and right click to activate the add, delete, or undo delete drop down box.  Click the add option to add the livestock unit.  In the far right hand column, type in a unique name to identify this livestock group.  The name entered here will be used in the report and for the remainder of the software.  If the animals are off-farm at any point during the year, only include the numbers of on-farm days in the column for # of Days per Year Housed in this Unit.  If manure is handled by two different systems for the same livestock group, you will need to enter the livestock group twice.  For example, if you handle manure as a liquid in the winter months for dry cows but handle the manure as a solid for the same dry cows in the summer months then you will need to have two rows of data for each situation.  You will then need to adjust the # of Days per Year Housed in this Unit for that specific situation.
[image: image7.png]= Oregon OnePlan Conservation Planner, (ASABE Paj

Fie Edt Records

Tools View Help

Conservation Plan)]}

sion 1.00.02 F

20, 2008]|

o [ [ s [ (s [T [ s [ G s |

Livestock Units

A Livestosk Urits a group of aimals housed together tha produce manure with a characteisic nutient content. To delermine a Manure Livestock
Urit, selector assign each parameter below:

- Right click to Add or Delete enties)

add

Delete
Unda Delete:

FolDaysper
por [ wegh Tons o Bedding | Give aUniue Name o

prindCers | HounaTowe |15, [picanima|PoddaTee | remowssdin | FELC TN | ook U

Leoretor g T 1 st 5 350 ik o

DyCow Fiee Sl P 1350 PoperPup 5 74 Oy Con

Daiy Heer

f e T— 7 50 Paper Pl 5 147 Heier

DI g F) 250 Loose Staw 5 w2 cat





[image: image59.png]= Applying Bio-Nutrients to F.
| “Instructions

Select a Manure or Other BioNutrent
Group fram the diop down menu.

N tint S
| E—

To apply a BioNutent Group select a
greenshaded Field. Place the cusor over
the Fild and click the mause (1speat
ppling to mutple Fields) The fekd wil
tutn yellow, indicating that the selected
Biontient wil be appied tothe feld

‘When iished appbing one Bio Nuent
Group, select anolher and repeat the
above process.

CROSS-HATCHED FIELDS ARE NOT
AVAILABLE FOR APPLICATION.

BioNutints may ot be appled to Fields
with a ross hatch palter. To remove the
cioss halching, go o the Crop section and
designate tht Field for 2 BioNutint
application

‘When fiished assigning all
BioNutint Groups, Cick.

“Dane." Youll then assin Dore.

cortesponding spplicaton raes.




[image: image60.png]Bio-Nutrient Application Schedule and Crop Bio-Nutrient Budget

Bio-Nutrient Application Schedule
OnePlan has scheduied application of BicrNutent groups on your felds at an average phospharus uptake ratefor the rotaton, with a coss-check to assure
that nttogen i ot over-appliec. I there is no unoif on th fel, the soi test phosphorus i below the thieshol, and the soi has recently been tested or
ittogen, you can apply bo-nutiets torittogen ates only ding the curtent crop year. However, applcaton raes are based on minerafzation of ritogen in
manure, and that mineralization can be affected by a muitude of things and canat be predicted wih gaod precison. Because the: biotients appled
may not be inmecltely avalable, cansiderstatr ferizer. Nilrients applied i pounds per acte are displaped to the fight.

Select 3 year ] Viewtupdate all vears to calculate application rates.

‘Application Bio-Nutrient Group.

Rate Type Application Rate-tons/acte e e relisd
Waste

NP Storage. Sold | Separsted

Limit _ Limit | None| Field Acres. Pondls] | Pasturels) = Stack(s) Solidfs) N P205 K20
FIELD T-Com,Fiekl Do 395 Not Applied NotApplisd ot Applied Not Appled |NIND INRRANNND MMM
FIELD T-AafaHay, Dor 395 Not Applied NotApplied Not Applied Not Appled INNNNNNNIND 0 NN
FIELD 2Pasture, Good{  11.6 Not Applied 17.4 NotAppied ot Applicc [N INNNZS IMNNIEE
FIELD 3Pasure, Good 92 Not Appled Not Applisd Not Applied Not Appicd IO 0 Y
FIELD 4Com,Fiekl Dou 124 Not Applied NotApplied Not Applied Not Appled INNNNND 0 NN
FIELD 4AlafaHay, Dor 124 NotApplied NotApplied Not Applied Not Appled IO 0 [N
FIELD 5 Pasture, Good 1.3 Not Appled N Applisd ot Applied Not Appic [ENNNIND INNNNNNND Y
13

Tons Remaining 9 3952 387

Less than Crop Rotational P205
{use "None" button to decrease
applicaton scres]

Cakelae Applation Retes View Ful BioNutert Budget | [ Acoeotabl Rete

Vald orly for years where: M Unacceptable Rate:
pplication Schetie has been run ] ; .

I~ Schede Edior[planners, or)  OnePlan wil assume all excess bionutients wil be exported.



Several of the requested inputs utilize drop down boxes such as the “Animal Class” box shown below.  The user must select one of the choices in the box by moving the cursor up or down to the chosen selection using the arrow keys or by “Left Clicking” the mouse on the proper choice.  Continue making appropriate selections in all the columns.
NOTE:  Animal weights and tons of bedding produced can be overridden by the user. 
Bio-nutrients
Manure Distribution

Manure is produced and stored in a variety of ways on livestock operations. Some manure is stored as liquid, while other manure is stored as a solid and some manure is deposited directly onto cropland. The storage and handling of each of these types of manure affect the nutrients that are retained for crop usage.  When the livestock units were defined in the preceding Livestock Tab the amount and nutrient value of the manure was determined.  It is now necessary to determine the distribution of manure.  Note the check box at the top of the page that allows the user to select to use the “Assisted Mode.”  This mode will utilize a set of default values for the manure distribution.  Advanced users or special situations may need different values from the defaults.  To override default data, remove the check in the box by left clicking in the Assisted Mode box.  The Manure Distribution Tab is divided into three (3) sections: Manure Sent to Wastewater System, Solid Separation, and Manure Groups.
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Manure Sent to Wastewater System

[image: image64.png]OnePlan Conservation Planner, (BOSY’S BEST DAIRY. Conservation Plan) [Version 1.72 June 10, 2005],

Flo Edt Records Took Vlew Help

Intoduction | Livestock | BioNutients | Siaing | Ciops | Inigation | Resource Concems | Application | Nutient Risks

Intoduction | Application Scheche, Crop Budget | Commercia Fertlzer | Export Nutrients

Exporting Bio-Nutients from Your Farm or Ranch  [Frey 5o 3o Sres o s meses ke
Instructions

Selecta BN o ["FEmaRaTGeT
andrecont e Brpor deals ke o Flcord he anurt f s i
d ots Beot deak e Uit Nutrient that is being exported and

o ot Group [ #Tons|FequhedAcrs o Expor] - the consumer o & reseng ¢
Waste Storage Pond(s) 0 0 0
Lo o 0
Separated Solid(s) 0 0 0
Pasture(s) 66 335 17
oS ety [Right click to Add or Delete entries]
o B it Gy B
Exported Consumers Name, Location of Faim and Avaiable Acies for Appication ]
BioflutientGroup Name | Aumoun N ofConsumer | Corsumers Address |Gty | Stale[2p[Telephone | Acres
Solid Stack(s) 50 Neighbor John Nest Door 40
Solid Stack(s) 137 Neighbor Frank. Nest Door 40

200 Neighbor Joe Newt Door 0

Sold Stacks)




The “Manure Sent To Wastewater System” requires the user to identify what manure is being handled with water.  Only those livestock units whose manure is being handled with water will be affected by the Separator choice.  For example, you can create a separator choice in the Solid Separation section that applies to the Milk Cow, Dry Cow, and Heifer.  However, if one of the two flush columns is not checked for the Heifer row then manure values will not be displayed in the “Separated Solids” columns at the bottom of the screen for Heifers.  

The Scrap check boxes at the top allow the user to identify if waste is being scraped from the parlor, holding pen and/or barn.  The program estimates the amount of manure on a dairy operation to be 10% from the parlor and 5% from, the holding pen.  If either is being scraped, the amount of manure entering the liquid stream is reduced to 0% for the value where scraping is being done. When the boxes in the “Flush Feed Alley” or “Flush The Housing / Bedding Area” are checked the amount of manure entering the liquid waste stream is increased accordingly.  
The value entered in the “Percent of Time on Pasture” is used to move the proper amount of nutrients from the storage facility to pasture.  If nutrients deposited on the pasture should not be considered in the nutrient balance calculations then the # of Days Housed in the Unit should be adjusted on the previous screen.  For example, in many cases when animals are solely grazed (not on feed), the nutrients deposited on the field and the nutrient uptake of the crop are considered equal.  In this example, the animals should not be considered on farm for purposes of this plan.  To remove animals from the farm, the user needs to adjust the # of Days Housed in this Unit.  
Solid Separation

Once the amount of manure entering the liquid waste stream is calculated, planners can elect to calculate the amount of separated solids that are removed when solid separation is a part of the waste handling system.  Planners have the option of using either 1) no separation, 2) one separator, or 3) a combination of separators.  Use the Add, Edit, or Delete keys to modify the solid separation system.  Once the separator or combinations of separators have been selected, the program will calculate the expected amount of solids that will be removed from the liquids.   [image: image65.png]Exporiing Bio-Nutrients from Your Farm or Ranch o4/ o2 CoRtenisen o o o oreh
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Manure Groups

The Manure Group table is populated based on the inputs in the two preceding sections and by the inputs from the Livestock Units Section. When the “Assisted Mode” is NOT checked, planners can use their own values in the % manure columns.  The reason for using custom values should be documented in the plan [image: image66.png]Phosphorus Runoff Risks and Management
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summary.
Nutrient Content and Other Bio-Nutrients

The program estimates the amount of nitrogen loss that occurs based on the type of storage and the method of application.  For people familiar with the Oregon Animal Waste Management (ORAWM) spreadsheet, it is important to note that the nitrogen loss values used in OnePlan are the same values used in ORAWM.  In this section, the planner will be required to enter information that describes the handling of manure in 1) waste storage ponds, 2) solid stacks and 3) separated solids. Storage, handling and application all have an impact on the amount of nutrients retained for crop production.

Data Source

If the planner has lab data for a particular source select the source in the Data Source section and choose the radio button for Nutrient Lab Analysis.  You will then be prompted to enter the lab data.  If lab data is not available then use the book values that come with the software.  Once the data source selections have been made, move to the Nutrient Availability section.
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Nutrient Availability
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The Nutrient Availability section of the screen requires the planner to define the type of storage that is being used for each of the types of manure groups being stored.  Storage types will dictate the amount of nitrogen that is lost during the storage period.

[image: image68.png]OnePlan Conservation Planner,

Owner Information Planner Information
Select Ouner

S - et [
First/Last Name ’7 ’7 Position Title ’7
e — e
e — Phone ——

Oyt [ [ [
Phonel —
Phonel

Desciption

Phone2 —

Phone2

Desciption
‘Add Additional Quner (up o 3) | Delete Duner

Producer Summary Information

Facily
Summary

Resaurce
Concems

Reconmendation
For Best Practices

Update Producer Summay Iformation Close.




Planners will also have to identify the method of application that is being used for each of the manure groups.  Application methods have varying values for loss of nutrients.

Next, the planner should make a selection in the “Days to Incorporation” column. The result of profiling the manure group storage, application and length of time for incorporation determine the pounds of N, P2O5 and K2O that will be available for crop production.
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When it is necessary to add an imported bio-nutrient group, the planner can simply name the imported bio-nutrients by entering the appropriate name in the space provided and press the “Add” button.
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Should it become necessary to remove a bio-nutrient group, the planner can select the appropriate group from the drop down list and press the “Delete” button to remove the unwanted group.

The planner can override default nitrogen retention values by clicking on the Change Values button near the bottom right corner. When a change is necessary, select the manure group and then press the “Change Values” button to access the screen as shown on the right, which allows entry of the new value.  Note that when changing the default value, the planner must give a justification for the change being made. This justification will be noted on the final printout. Remember that a change in the value must be justified and approved by the Department of Agriculture.
Sizing
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The sizing module is intended for those facilities needing a sizing of storage facilities for process water, runoff, solid manure storage or a gravity separator.  If multiple animal groups are a part of the operation, process water entry will be required for each of the different groups. The “Tabs” for each of the groups asks for appropriate information regarding the process water used by the various types of production and management practices used with the selected animal group. Planners can select to perform sizing operations, if needed, for liquid storage ponds, runoff areas where there is manure and from feed storage areas.  Additionally, planners can use the software to size separators and storage areas for separated solids or scraped solids.  The user can choose to send lot runoff to either a waste holding pond or to contain the runoff using a runoff containment berm.  
If the planner is preparing a risk assessment only on the manure produced on farm, manure exported off farm, or manure import on farm he/she can opted not to develop the facilities storage facilities needs.  To activate this option the planner will check the “No sizing at this time” option.

Dairy Process Water

Water Used to Clean Pipelines/Bulk Tanks
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The initial input requires the entry of the parlor type, which is selected from a drop down box. The user must enter the number of cows per side in the parlor,in the case where there are multiple parlors in the barn, use all cows in the barn when full and divide by 2 to get the appropriate number of stanchions per side.  The number of hours used per day is used in the calculation for water and should represent actual milking time. The question regarding direct loading of milk will eliminate the need for the entry of water use relative to the bulk tank. For smaller herds where milk is not shipped daily, the radio buttons to indicate frequency of shipment are used to factor the amount of cleaning water for the bulk tank. The number of cleaning cycles for the pipeline combined with the volume information is used to calculate the total amount of water used for cleaning the pipeline. When entering the number of bulk tanks, press “Return” to get the entry windows that contain the input cells for bulk tank water requirements.

Check Dairy Water Calculations
The “Check Dairy Water Calculations” button provides a summary page that displays all[image: image74.png]


 of the various water uses in the dairy barn. It is quite handy to review all of the sources of water that have been entered up to that point. You cannot edit in this screen.  You will need to go to the tree (CTRL T) to move to the correct spot to make the edit or correction.
Water Used to Prepare Cows for Milking
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The second entry screen for entering the “Dairy Process Water” information deals with the preparation of cows for milking. The use of a wash pen requires the entry of the appropriate information for determining water use. The number of cows in the holding pen is used to calculate the number of times the holding pen will be used on a daily basis.  Enter the total number of sprinklers that will be used to wash the cows. If it is unknown, consult with the equipment dealer for assistance in calculating this information.   The length of time that the sprinklers are on each string will be used to determine the amount of water used; overestimation of the time is better than underestimation.  There is a text box for use in explaining the procedures in the wash pen. When in doubt, add comments to be sure the entries are explained.

Once the wash pen information is entered, the user will be given the opportunity to enter information about cow prep in the barn. Normally, about .5 gallons per cow is used to wash cows in the barn when drop hoses are being used. Users can include water from a backflush system by checking the “Yes” radio button. Automatic systems use about .5 gallons per cow. When manually backflushing, .5 gallons per cow is a reasonable number to use for water usage.

Note: The “Check Dairy Water Calculations” button continues to be available on these Dairy Process Water calculation pages and keeps a running total of water usage. It is quite handy to review all of the water that has been included up to this point.
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Water Used in Cleaning Milk Parlor and Holding Pens

The next step is to enter the water used in cleaning the barn and holding pen. The various methods of barn cleaning and holding pen cleaning are listed in “Check Boxes” on the Water Use “Tab”.   
Check the cleaning method or methods being used in the barn or holding pen or the method that best describes how your barn or holding pen is cleaned. The method(s) selected will become active and will allow you to enter data.  
Hose Volume Help
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The hose method has a "Hose Volume Help” to assist the user in determining the flow rate by timing a collection in a bucket.  When the user enters the volume of the container and the time it takes to fill the container; the program displays the calculated flow rate.  The values for the blue text are calculated by the software
When using the flush method of barn cleaning, the user will need to know the flow rate of the flush. If this information is not available, consult the dairy equipment dealer.

The deck flush method will require the entry of the number of nozzles being used to do the deck flushes. The flow rate and minutes per flush must be entered, along with the number of flushes per day. Again, overestimating the amount of water used is better than underestimating water use.
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Water Used with Dairy Equipment

In some cases, cooling equipment water can make up a sizeable amount of the total water to be stored. The planner must visit with the producer and determine all sources of water that comes from the cooling equipment. Cooling water may be used for vacuum pumps, compressors for cooling equipment on bulk tanks and for cooling the milk equipment itself. The use of water to cool can increase efficiency and reduce energy requirements for the dairy operation, but in many cases, poor planning for disposal of cooling water has created a problem in the management of waste. Cooling water should be recycled where possible to take advantage of the increased temperature of the water once it has been used for cooling. Use of this water for washing cows and for cow drinking water can be highly beneficial from an energy conservation standpoint.

Compressors are often cooled with water. If a water-cooled compressor is used in the barn, check the “Check Box” and the cells become active and ready to accept data. Enter the flow rate in gallons per minute for the compressor. If unknown, try to contact equipment dealers to help identify the water use. Enter the total time the compressor is operated daily.

If water is recycled, it is not added to the waste storage pond unless the amount of water needed in the areas that utilize recycled water is less than the amount of water generated through cooling of the compressor.
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When the radio button for recycled cooling water is selected, the planner will need to identify where water is being recycled. Check the appropriate “Check Box (es)” to indicate where the recycled water is being used.

Vacuum pumps may also be water-cooled. Just like compressors, the user must provide the gpm usage of clean water and the minutes per day that the cooling is needed. Again, identify if the water is recycled and where the recycled water is used. If the water used for recycling is less than the amount of water needed, the excess water will be sent to the waste holding pond, unless otherwise specified.

Milk cooling is another source of water used for cooling. Plate coolers generally use up to 2 gallons of water to cool 1 gallon of milk. The program will allow the user to adjust the ratio values as needed. Entering the production allows the program to calculate water usage for cooling. Check the boxes for each system if multiple systems are being used. For example, a producer may use a glycol chiller and a plate cooler.
Water Used in Cleaning Miscellaneous Equipment/Milk House Floor
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The final entry will gather miscellaneous uses of water.  These uses are generally not considered recyclable. The washing machine water drop down allows the user to identify the disposition of the water; it may go to the waste holding pond, septic tank or be handled separately.
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Flush of Freestalls and Feed Alleys
The flush for freestalls and alleys will affect the amount of water stored if flushing is done with non-recycled water. When non-recycled water is used, the amount of storage required increases.  When recycled water is used, the volume changes only by the amount of manure that enters the storage.  Be sure to accurately reflect the amount of manure being stored in the Bionutrient group.
Runoff Calculations
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Runoff that comes into contact with nutrients must be contained.  Runoff from different categories such as roof, loafing lot, etc can be characterized here. Select the type of surface for which the runoff originates, the slope of the area and the method being used to contain runoff.   The rainfall data, which is populated in the cells at the top of the page, is based on the weather station selected earlier in the program. These values can be increased but must not be decreased. The calculation for runoff is made for each runoff area. Individual areas are entered on the top line (Surface Runoff Areas).  Note: The type of surface that is used and the percent of slope will dictate the runoff factor being used.

Right click in the gray area to create a new runoff line item.  When all runoff areas have been captured, click Next to proceed to the next screen.  If an area is incorrectly entered, the user must select the faulty entry and delete it.  Once the bad data is deleted, the area may be re-entered.
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The Runoff Regulations button on the upper part of the screen will provide the planner with a brief overview of the regulations that apply for runoff on livestock operations in the state of Idaho. This information will be updated for Oregon in the next version.  In the meantime refer to regulations from the Oregon Department of Agriculture.

Identifying and Sizing Manure Storage Units
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This page helps the planner determine the size needed for all the waste storage facilities. The planner can identify the Existing Storages and, if necessary, add additional storages, New Storage Containers, to contain all of the waste. The “Annual Liquid Capacity Required” table on the right hand side of the screen provides the planner a quick accounting check on all liquid manure, runoff, and solid manure that was identified as requiring storage.
Add Storage Structures
When the planner selects the “Add” button in either the “Existing Storage Container” or the “New Storage Container”, a screen is displayed with several options.  The planner will need to choose the “Unit Shape”, “Unit Type”, “Storage Period” and the percent of manure that should be contained, “% Contained” with this unit.  The planner will define the actual containers for the storage and will need to continue to add and size storages until all of the waste is contained.  The program will calculate the remaining amount of storage needed, updating the “Required” values after each storage is added until all of the storages have been created and sized.  Once the storage facilities appear in the list, the planner can click in the “Edit” column to Edit a particular row.

If the total volume to contain is larger than the total volume of the storage facility then the software can create a “New” storage facility with the remainder if the user chooses that option.  
The sizing tool is used by first determining the “% Contained” of a particular source, “Bio Nut Group” of waste that must be stored in a particular storage unit, “Unit Type”. In this example[image: image85.png]Idaho OnePlan Mapping - Microsoft Internet Explorer BE
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, we are working with solid waste only and the storage period is 154 days determined by the Storage Period Assessment Worksheet which will be incorporated into the next version of ONMP.  The values in the “% Contained” column represent that percent of waste from that “Bio Nut Group” that is being contained in this particular solid stack.  The “Total Volume to Contain” is greater than the “Total Volume” of the facility which means this facility is undersized.  The planner has 3 options in this case: 1) reduce the values in the “% Contained” column so that all the waste is contained, 2) increase the dimensions of the Storage Unit to make the facility large enough to contain all the waste or 3) create a “New Storage Facility” to contain the remaining waste.  In this particular case, a new storage facility will need to be created anyway in order to contain the “% Un-Contained” manure.
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When entering the information for the structure, the planner may either enter the dimensions and solve for the amount of volume, or enter the volume and solve for any one of the dimensions by checking the box of the dimension for which they wish to solve.  This is particularly useful when calculating either new facilities or for additional storage units on an existing facility when there is a shortage of storage. 
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Several different types of storages or several of the same type of storages can be used to contain the necessary waste. The different types of storages that can be calculated with the storage calculation tools are listed to the “Unit Shape” dropdown.

Just as in the solid storage structure design feature of the program, the planner has the option of selecting a liquid storage structure design.  When developing a plan, a planner should refer back to the Sizing Manure Storage Screen to see that all of the required storage is accounted for before moving on to the next section of the plan.  However, in this version of ONMP, freeboard is NOT accounted for in the liquid sizing page.  This will be corrected in the next version.
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Crop Rotations Patterns
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To complete the nutrient balance, it is necessary to characterize the cropping information for the fields receiving manure. The first step is to develop the various crop rotations for the operation. An infinite number of rotation patterns can be developed. The program is designed to allow the planner to use either single or double cropping patterns. 
The module utilizes nutrient uptake rate for each crop selected in the rotation.  Crop uptake for the various crops is based on the crop yield.  It is important that the planner uses the same unit of yield as the data entered in the programs data base.  Units of yield can be in tons, cwt, lbs or bu/acre. Notice the note at the bottom of the Crop Rotation Pattern screen.  To find the units used in the average yield column, hover your mouse over the value.  DO NOTE duplicate the name of any of the rotations. If two rotations using the same Rotation Name are entered, the program will fail.
To enter a rotation, simply select the crop using the drop down box for each year in the rotation. If there are more years in your rotation than the ten allowed, enter the first ten in the rotation beginning with the previous year crop.  In addition, the user can easily scroll through the crops by pressing the first letter of the crop desired.  If the double crop “Radio Button” is checked, a second set of columns will appear, however, double cropping is not common in Oregon.  For each crop entered, the planner will need to check the box next to “Bionutrients” if manure is being applied to that crop.  If the check box for “Bionutrients” is not checked, the software will not make that crop available for bionutrient application in future screens.  In years when a second crop is not grown, enter “N/A - No Second Crop” as the second crop.

When finished entering a rotation, press the “Save this Rotation” button.  Click the “Next Rotation” button to enter more rotations. If a new rotation that is nearly identical to one that already has been entered is needed, press the “Copy Rotation” button, make the necessary changes, including a new name and the rotation will be created. When all rotation patterns have been entered, press the “Next” button to proceed to the next section.
Assigning Crop Rotation Patterns
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Once the rotations have been completed, each field must be associated with one of the crop rotation patterns that have been entered.  In SECTION 1 the planner will need to assign the desired rotation schedule by selecting the field, crop rotation, and current year of the rotation.  In SECTION 2, the planner will be given an opportunity to adjust the yield information for the specific field being entered. The use of bionutrients can also be changed for a specific field at this point, as well. SECTION 3 asks for the fertilizer application date. The fertilizer application date represents the first application of nitrogen fertilizer.  The software uses this date to being applying nutrients to the field.  The program also uses the date entered to determine if the soil test is within the 12 month period as required by Oregon’s Nutrient Management 590 Standard.   Go through each of these sections for each field.  The information that is typed is automatically saved so you can just move from field to field using the drop down list and everything is saved.  When done with all the fields, click Next.
Irrigation Planning

Irrigation plays a major role in the movement of nutrients both off the field when runoff occurs and in field when nutrients can move through the soil profile under deep leaching conditions.  The irrigation portion of ONMP does not meet the requirements of an Irrigation Water Management (IWM) Plan.  The planner should use other tools to complete an IWM if that is the desired product.  The irrigation component of ONMP is meant to provide the planner with general planning information about irrigation. 

Proper irrigation will result in making the best use of nutrients for crop production and will reduce the potential for environmental degradation due to the movement of nutrients from a beneficial site (crop root zone) to a non-beneficial site (surface and ground water). If the user follows the irrigation plan the use of water and nutrients will be maximized while minimizing the impact of those nutrients on the environment.  
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The irrigation “Tabs” that appear were established based on the selection made previously in the software for the “Crop/Irrgation/Dryland” selection made on the “Map Your Farm” window.  The three irrigation tabs (Surface Irrigation, Center Pivot Irrigation, Big Gun, or Hand or Wheel Line Irrigation) are automatically activated as the planner proceeds through the irrigation model.  Each irrigation model is unique in its ability to evaluate the system.  However, all four systems are similar in type of information required.  The instruction section for each system contains three sections: 

1) Field Selection,

2) Irrigation System Characteristics, and

3) Irrigation Start/End Date.

The first step in the surface irrigation process, Field Selection section, is for the planner to identify the field.  In Irrigation System Characteristics section, the planner enters details specific to the irrigation system and the field.  Irrigation Start/End Date section has entries for seasonal irrigation start and end dates.  These dates are used by the model to evaluate irrigation efficiencies based in Net Irrigation Requirement (NIR) and determines the date that water balance is achieved.  The software will also determine if the field is in a water deficit or leaching pattern.  
Surface Irrigation
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The Surface Irrigation “Tab” provides auto calculation and immediate viewing of “Gross Water Applied Each Irrigation, Water Required per Irrigation, Application Efficiency, Runoff Index Percent and Percent Water Applied that is Deep Percolation”.  To use the surface irrigation tool, the user must first define the type of delivery method.  
The three types of Delivery methods that a producer may be using are: 
1) siphon tubes, 
2) gated pipe, and 
3) earthen ditch with cutouts.  
Siphon tube and Gated pipe allow the producer to control the water better than the earthen ditch.

The next step in evaluating a surface irrigation system is to “Enter Characteristics” of the field.  These values of furrow or field length furrow or border spacing and time to reach end of furrow, and furrow flow rate are used by the model to calculate gross water applied, irrigation required, % runoff , application efficiencies %, and the % potential for deep leaching.
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Flow Rate Estimator
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The surface irrigation model uses a number of parameters that influence the flow rate in a furrow. The flow estimator can be invoked by pressing the “Flow Estimator” button.  This will assist the planner in determining the furrow flow rate for the Delivery Method. For example, if the grower is irrigating with siphon tubes. This tool requires the user to enter the diameter of the tube, the elevation difference between the water level in the ditch, and the level where it is discharged from the tube into the furrow.  The greater the difference in elevation and the larger the tube, increases the resulting flow rate.
To estimate flows for Gated Pipe systems, the planner selects the “Flow Estimator” for a Gated Pipe system, selects the width and height of the gate opening on gated pipe, and selects the elevation difference between the gate and the level of water in the ditch.  The flow is provided by the “Flow Estimator”.  This flow value is then [image: image95.png]% C:\Program Files\USDANRCS\OregonNutrientPlanner

Fle Edt View Favortes Took Help

Qs - © - (] 5ot iy s

ez [ CiProgram Fies|USDANRCSHOregontitrientPlanner

Fders X _tiame s - Tyee
| (Dpatabase File Folder
* Sreponroms o Folder
Sresouces i Foldr
T oRtistietlnner i 1K6 Configrtion etings
E 16 UCHe
S eshsepepercon 16 oPPFic

onp a0 [



carried over to the appropriate line on the data entry form.
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A “Flow Estimator” is provided for earthen cutouts. This tool requires the user to collect a volume of water in a bucket and to record the time.  Another method to consider is to identify the flow delivered by the irrigation district or company, i.e., 1 cfs = 454 gallons per minute. If 1 cfs is distributed to 100 furrows, the flow rate is 4.54 cfs.

Irrigation Start/End Dates

The third step is to enter the seasonal Start/End dates.  
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The dates entered impact the start of the NIR calculations below for the current crop in the rotation.  This information is used to determine if the system is over or under irrigating.  
The next major step in evaluating a surface irrigation system is to enter the “Set Times for Single Furrow Run”.
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Enter the set times for each month when the selected field will typically be watered. In the example above, set times are for 12 hours and the months of irrigation are from May l until October. Once the set times are entered the software will automatically calculate “Gross Water Applied Each Irrigation (in)”.  

Irrigation Efficiency

Since the surface irrigation module works on monthly Net Irrigation Requirement (NIR) averaged over the month, the model assumes start of irrigation at the beginning of each month and will carryover NIR data from the last day of the preceding month.  When the planner [image: image99.png]Oregon OnePlan Conservation Planner (Example Farm Conservati
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provides the approximate number of “Days Between Starts of Irrigations”, the software evaluates the irrigation system’s ability to provide the needed water for crop production based on the length of set time and the flow rate. The water holding capacity is based on information found in the soils layer of the GIS data.  The “Too Long Between Irrig. Starts” check boxes indicate a lack of water to meet crop needs.  Once the planner enters the “Days Between Start of Irrigations”, the program will calculate the NIR, “Water Required per Irrigation” and evaluate the system’s ability to deliver the necessary water to meet crop production needs without applying excess water that will move nutrients through the profile. The planner can make adjustments in the length of sets, flow rate and/or the interval to allow the system to meet the crop needs while maximizing the “Application Efficiency %” and reducing the movement of water through the crop root zone into the ground water.
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Determining Excessive Runoff

The Surface “Runoff Index %” is calculated as an indicator of the potential for loss of soil and nutrients due to surface runoff. A runoff index of at least 25% is necessary to allow for uniform wetting of the soil by providing enough time for water infiltration at the end of the field.  Runoff indexes of shorter durations indicate a higher potential for erosion and nutrient losses.  To increase the index, increase the set time and/or increase flow to reduce time to end of the furrow. To reduce the index, reduce the set time or reduce the flow in the furrows. 
Estimating Effects of Deep Percolation
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Deep percolation of irrigation water may carry nutrients through the soil profile and potentially to groundwater.  The “% Water Applied that is Deep Percolation” calculation will evaluate the potential for moving water through the soil profile. The evaluation examines the amount of water used by the crop compared to the amount of water applied through irrigation. The difference between the amount of water used by the plant, evaporation from soil and plant plus that lost through runoff, and the total amount of water which was applied is considered to be deep percolation.  Deep percolation is the movement of water to the aquifer. This process has the potential to carry nutrients through the soil profile to groundwater and can generally be considered a waste of water. It is important to remember that aquifer recharge is also an important result of deep percolation. In many places, irrigation is responsible for a substantial change in the ground water depth.
Irrigation Field Copy
Once the planner has completed the entry for a field, the next field can be entered by returning to the top portion of the screen and selecting the name of a new field. The planner also has an option, “Copy this Field” for copying the finished field’s irrigation information to the next field under the same system for irrigation.  
When the irrigation information is entered for all fields under the Surface Irrigation, pressing the “Next” button will take the planner user out of this “Tab” and on to the “Center Pivot”,
“Hand /Wheel Line”, or “Big Gun” tab.  If there are no fields identified as being irrigated those systems, the program will move on to the next section in which the user will identify the fields with runoff.
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Center Pivot Irrigation

The flexibility in customizing application rates with a center pivot application allows the producer to spread liquid manure at the desired rate and uniformity across the field. As with the surface irrigation system, when the field is selected, the acreage and the crop for the current year information is populated. Enter the flow rate of the system in gallons per minute.  If this information is not readily available, the irrigation [image: image103.png]Oregon OnePlan Conservation Plannes
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equipment people who installed the system should be contacted for the information.  
The planner then needs to estimate the amount of runoff associated with a center pivot. The amount of evaporation will also need to be estimated. The normal range for evaporation is from 10 to 15%. The higher pressure and smaller droplets will result in a greater amount of evaporation.  The date of the expected first and last irrigations must be entered so the program can calculate water usage by the crop.
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Once the system information has been entered, the next step is to enter the Irrigation Management information.  Section 1, in the lower part of the entry screen, requires the planner to enter the number of hours that it will take to make a complete circle with the pivot.  Press the “Water Applied” button to calculate the amount of water applied per acre per revolution (irrigation) of the pivot.

During the early and late season, crop evapotranspiration (ET) is lower than in the middle of the irrigation season. During the middle of the season, the system will need to apply more water to maintain crop ET needs. Care must be taken to avoid planning application rates that exceed soil infiltration rates. If application rate exceeds infiltration rate, runoff or ponding become a concern. Many systems are designed to meet less than the total crop ET needs during the high demand periods in July and August. 

The next step in evaluating the pivot irrigation system management is to provide the number of days between irrigations in Section 2. Early and late season irrigation will again require less frequent irrigation since crop ET levels are at their lowest point. Enter the estimated days between irrigations. Press the “Calculate Balance” button to calculate whether crop needs are being met or if excess water is being applied, resulting in deep percolation of water and nutrients. This information is displayed in Section 3 of the screen.

If soil moisture is at deficit levels, the planner should adjust the amount of water applied by either increasing the number of hours to make a revolution or by decreasing the interval in days between irrigations. Make the necessary adjustment and press the “Water Applied” button to recalculate the water application and then press the “Calculate Balance” button to recalculate the water balance information.  If deep percolation of moisture and nutrients is indicated, the planner should adjust the amount of water applied by either decreasing the number of hours to make a revolution or by increasing the interval in days between irrigations. Make the necessary adjustment, press the “Water Applied” button to recalculate the water application and then press the “Calculate Balance” button to recalculate the water balance information.

Once the user has completed the entry for a field, select the next field to be entered in the drop down box on the top part of the screen. If there are additional fields having pivot irrigation systems, the program will provide a new input screen for the next field the planner chooses. Pressing the “Next” button will take the planner out of this “Tab” and on to the “Hand or Wheel Line” or “Big Gun” tab.  If there are no fields with hand lines or wheel lines or big guns, the planner will exit the “Irrigation” tab and move on to the next section, in which the user will identify the fields with runoff.
[image: image105.png]Watershed Information
Walershed

fllamette

Hydiologic Urit

fi7080010

Sl Conservation Distit

Washingian

Select a clinale staton that s
most suied ot your operation
from the ciop down menu.

Clmate Station



Hand or Wheel Line Irrigation

The flexibility in customizing application rates by varying application times allows the producer to spread the liquid manure at the desired rate and uniformity across the field. Just as in the previous two irrigation methods, when the field is selected, the acreage and the crop for the current year’s information is populated.  To use the Hand or Wheel Line Systems section, begin by entering the flow rate of the system in gallons per minute. If the flow rate of the system is unknown, refer to the irrigation equipment manufacturer or the company that installed the equipment. If the user can not obtain the flow rate information, the “Flow Estimator” should be helpful in providing the information. An example of using the “Flow Estimator” can be found later in this section. The next step will be for the planner to estimate the amount of runoff associated with this method of irrigation. The amount of evaporation will also need to be estimated. The normal range for evaporation is from 10 to 15%. The higher pressure and smaller droplets will result in a greater amount of evaporation.  The date of the expected first and last irrigations must be entered so the program can calculate water usage by the crop.
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Flow Rate Estimator

To use the “Flow Estimator” the planner will need to enter the nozzle size for the birds being used. If birds have a second nozzle, the second nozzle must also be entered. The pressure at the nozzle must be taken so that it can be used in the calculations for the amount of water output per bird. If the pressure at the nozzles is unknown, the program has a pressure estimator. The number of nozzles entered must be all nozzles used simultaneously on the selected field. For example, on our sample field; assume 2 hand lines are being used to irrigate the field. If each line has 18 nozzles, the number of nozzles would be 36 if the normal practice is to use both hand lines simultaneously. 
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When the pressure at the nozzles is unknown, the pressure can be estimated using the estimation tool.  Enter the pressure at the pump and the difference in elevation between the pump and the sprinklers.  The planner must identify if the pump is located above or below the sprinklers.  The location will determine if there is a pressure loss or gain in the system. The type of mainline must be entered. Different types of pipe have different coefficients of friction which affects the amount of pressure loss. The size of the pipe and the flow rate also affect the amount of pressure loss within the mainline and must be entered. When all of the information has been provided, press “Calculate Pressure” and the estimated pressure will be displayed and returned to the pressure blank on the Flow Rate Calculator.
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After the flow information has been entered the planner must provide irrigation information such as the number of days it takes to irrigate the field using the current irrigation system. Upon entering “Days to Irrigate Field Completely” and “Down Time per Day”, the program calculates the “Gross Water Applied Each Irrigation”.  Depending on the operation, the producer may or may not be able to adjust the rate at which they are able to cover the entire field. Some canal systems are not designed so that producers can take periodic delivery of water; that is, they must take delivery 24 hours per day.  This practice can limit the flexibility in adjusting application rates to the crop ET needs. The time it takes to change the position of the lines on the field or the time the system is off for part of a day is called down time. The water that would have been applied during the time if the system were running will be subtracted from the total and can amount to a significant amount of water, particularly if the user is using a set time of 18 hours with the system being down for 6 hours.

During the early and late season, crop evapotranspiration is lower than in the middle of the irrigation season. Producers typically may adjust application from 12-hour sets to 24-hour sets. During the middle of the season, the system may need to apply more water to maintain crop ET needs, which usually results in the longer set times.

Care must be taken to avoid planning application rates that exceed soil infiltration rates.  If application rate exceeds infiltration rate, runoff or ponding become a concern. Many systems may lack the ability to provide application timing or rates that meet the total crop ET needs during the high demand periods in July and August. Once the days to cover the field are entered, press the “Water Applied” button to calculate the amount of water applied per acre, per irrigation.
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The next step in maximizing the irrigation system efficiency is to identify the number of days between irrigations. Early and late season irrigation may again require less frequent irrigation since crop ET levels are at the lowest. Enter the estimated days between irrigations. Press the “Calculate Balance” button to calculate whether crop needs are being met or if excess water is being applied, resulting in deep percolation of water and nutrients.  If soil moisture is at deficit levels, the planner should adjust the amount of water applied by either increasing application rate or by decreasing the interval in days between irrigations. When the planner makes application adjustment, press the “Calculate Balance” button to recalculate the water balance information.  

If deep percolation of moisture and nutrients is indicated, the planner should adjust the amount of water applied by either decreasing the application rate or by increasing the interval in days between irrigations. Make the necessary adjustment, press the “Water Applied” button to recalculate the water application, and then press the “Calculate Balance” button to recalculate the water balance information.

The planner should complete this process for all irrigated fields. Pressing the “Next” button will take the user out of this “Tab” and move on to the next section in which the user will identify the fields with runoff.
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Resource Concerns

Field resource concerns must be identified to determine the proper method of plan development from a regulatory perspective.  Those fields determined to have surface water as the primary resource concern will have different parameters than those classified as having ground water resource concerns. In this section the planner will identify if there are concerns from runoff due to surface irrigation or from sprinkler irrigation. The planner must identify runoff from both surface irrigation runoff or from sprinkler irrigation runoff.  Checking the buttons as seen on the screen to the right will give the planner a map displaying the fields for the individual category selected (either surface or sprinkler).
Records (Soil Characteristics)
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The planner can view the soil characteristics by going to the menu options and choosing Records -> Soil Characteristics.  
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The “Soil Characteristics” file contains basic soil information.  
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The “Soil Limiting Conditions” file contains data that the program utilizes in determining the presence of a subsurface feature that the program utilizes in determining groundwater risk assessment.
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Field Runoff 
Fields receiving manure pose a special problem from runoff whether from irrigation or from precipitation. If runoff occurs, the Resource Concern becomes a “Surface Water” resource concern.  Fields that are surface irrigated and do not utilize a pump back system are automatically assumed to have runoff.  If a surface irrigated field does not have runoff, the planner will identify that field by clicking within its boundaries which will turn the field green while the others remain yellow.  
[image: image115.png]Introduction

Itis impotant that al marre produced on the faciityor imported be
propely stored. In addion,al urof that comes in cortact with feed o1
manure sowices must be propery contained. If you own a daiy, al baim
walet that comes in cantact ith marure should be contained in 2 auid
manue storage pond

Please check each of the containment structuref) below that you
wauld ke to siz.

¥ Liuid Storage pond o cortan prosess wastewaler,

¥ Runoi from diy, swine or beef catls conal and feed stoage areas
R
Beim systemto contain runaff from carrals and feed storage areas.

I~ Eatthen raviy separalo, concrete graviy separato, of concrete
stacking pad for mecharical separation. OR
Concrete stacking pad or covered storage area for sl mare.

I No siing a his time.




The sprinkler fields as seen in the screen to the right must be identified if they DO NOT have runoff by “Clicking” on the field. If a field is not identified by selecting it, the assumption will be made that there is runoff, and thus surface water will be identified as a resource concern.
Subsurface Features
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The GIS layers which are downloaded with the maps include a great deal of information about each of the fields. This information is part of the soil classification information. In some cases this information may not be accurate for a small site such as an individual field. The Subsurface Features screen allows planners to modify the information that was imported with the maps if it does not accurately describe the individual field. The planner will check the box or boxes of the information which needs to be changed? One the box has been checked the planner simply makes the necessary change and moves on to the next field or presses the “Next” button to continue on to the next section.
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Well Water Analysis

The well name dropdown list will have the names of those wells that were previously identified on the maps.  Each well can be selected and the information entered specifically for the individual well. Enter as much of the information for each well as is available. Remember to identify the type of well. Examples of well types include: agricultural, residential, commercial and stock water. It is suggested to maintain well records over time to watch the trends.  Should it be necessary to edit a test that was previously entered, first select the well then select the date of the test you wish to edit from the “Test Date” dropdown list. Once the screen is populated with the test information, simply make the necessary changes.
Irrigation Induced Erosion
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Irrigation induced erosion has an impact on the phosphorus index which is used in the calculations and nutrient application recommendations. The purpose of this “Tab” is to identify if the practices being used on an individual field are holding soil losses to an acceptable level. If levels of soil losses are at an excessive level, the planner can, in consultation with the producer, utilize conservation practices, which will help reduce soil losses with the goal of reducing losses to an acceptable level.

Selecting a field will also select the soils information pertinent to the selected field and that data will be taken into consideration in the calculation of soil losses. The GIS information also provides the Soil Erodibility factor (K), which is used in calculating total erosion in tons of soil per acre.

The planner will select tillage practices that are being used on the field to evaluate soil loss potential. The residue factors will affect the phosphorus index which in turn affects allowable application of nutrients.
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Irrigation considerations include the slope of the field (user entered – in %), length of run, condition at the end of the furrows, and irrigation Best Management Practices that are being used. These items are entered by selecting the appropriate category from a drop box as seen in the example to the right.
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Irrigation Best Management Practices

The “Irrigation – BMP’s section of the screen will allow the planner to identify the practices being used that will help to reduce erosion.  Selecting PAM as an irrigation BMP, the use of conservation tillage practices and soil conserving crops as a part of the crop rotation will result in reduced erosion due to irrigation and impact the phosphorus index which is used in calculating allowable nutrient applications. The use of specific irrigation BMPs such as Irrigation Water Management and Surge Irrigation will also have an impact by reducing erosion. Select applicable BMPs by checking the appropriate check box for those applicable.
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Soil Testing
The planner must select the “Yes” radio button on the Soil Test page to start entering lab results.  Soil test results should be entered on all fields. If some fields have not been tested, enter the results for those fields that are most similar to tested fields. Note that the Phosphorus Index classes are provided for reference.
Soil Test Data Entry
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Regular (annual) testing is beneficial to establish baseline data and to build a history or to develop trends. The soil test entry screen allows the planner to compile a history of tests when multiple tests are entered for the selected field by using the “Add a Test Result” button.  Several test results can be entered for the same field.  
The drop down box under “Field” allows the user to select from all fields on file for entry of a soil test. The date of the test must be filled in to identify one test from another. To edit an existing test, simply select the field for which test you wish to modify from the dropdown list, select the date of the test to be modified from the dropdown list, and make the necessary changes on the data entry portion of the screen.

Do not enter data in the 12-24” or 18-24” column.  These columns will be removed in the next version.  The “Facts” buttons provide information regarding those specific items.
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Application of Nutrients to Cropland

The application section of the program will lead the planner through the following tasks:

· Determine the crop nutrient requirements for each field based on the crop grown

· Quantify the existing and expected nutrient sources in a field

· Schedule the application of manure or other bio-nutrients to meet crop requirements

· Schedule commercial nutrients, if needed, to satisfy remaining crop needs

· Identify application methods and timing of nutrient application
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Report excess bio-nutrients which must be exported
Identification of Fields for Application

The first step in the application of bionutrients will be the identification of the fields and the nutrient groups to be considered for each field in the application process. 
First select the “Apply to Fields” button to begin assigning the fields that will receive bionutrient applications.  Select the group of bionutrient you wish to apply and then simply click on the fields which will receive bio-nutrients.  After all of the fields for a specific group have been selected the planner can select the next bio-nutrient group to apply.  Simply repeat the process of selecting fields for the application until all bio-nutrient groups that will be applied have been selected.

Once the fields receiving bionutrients have been selected, the program displays a screen which identifies the Bionutrient Application Schedule and the Crop Bionutrient Budget. This summary can be displayed for any one of the years which are included in the plan.
Bio-nutrient Application & Timing




Once a year has been selected the planner can calculate the application rate necessary to meet crop uptake needs for the specific crops and in the specific fields. The calculation can be updated by pressing the “Calculate Application Rates” button found on the lower left corner of the screen. After the rates have been calculated the planner can “View Full Bio-Nutrient Budget” by pressing the button in the lower right hand corner of the screen.
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Note: The nutrient balance table on the right side of the screen is populated. All of the acceptable parameters are green. Those fields where nutrient application rates exceed recommended levels are colored red. Those fields where bionutrients fail to meet the nutrient needs for crop production are shown in light blue. These fields will need additional bionutrients or commercial fertilizer if yield potentials are to be reached.  Parameters identified by red must be corrected for the plan to become certified.

When the Annual Field-Crop Nutrient Balance is activated by pressing the “View Full Bio-Nutrient Budget” button planners can view the individual fields for a given year to obtain detailed nutrient information based on the recommend bionutrient application rates. The left side of the screen provides an evaluation of the nutrients taken up by the crop, those provided by bionutrients and those those are in either excess, balance or in deficit.
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When the planner selects the “See Details” button, the screen to the left appears and provides planners with the details for the legends which are used to categorize bio-nutrients and nutrient balances.  The parameters used to determine each of the categories blue, green, yellow, red and grey are explained.  This screen has not been updated for Oregon yet.  It will be corrected in the next version.
Commercial Nutrient Application and Timing
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Commercial Nutrient Application & Timing

Planners using commercial nutrients will be required to enter the method of application and timing of application. Both the timing and application provide drop down boxes where the user selects the method, or the one that most closely describes the application and timing of application. The planner can enter the amount of commercial fertilizer being used in the box on the lower right side of the screen. 
The balance is updated as the pounds of commercial fertilizer are entered. When excess commercial nutrients are added the color of the cell will go from blue which presents a potential nutrient deficiency to green which is acceptable levels then to yellow which is a cautionary level and finally to red which is an unacceptably high level of nutrients.

Exporting Nutrients
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In many cases, livestock producers have more nutrients than they can utilize on their own cropland. The nutrients to be exported must first be identified by bionutrient group and then assigned to producers who will be taking the nutrients to their farms. The farmers to which the nutrients are being exported must be identified by completing the form shown above. All of the requested information must be provided. Continue to add farms for exports until all of the nutrients have been accounted. Remember to account for all of the bionutrient groups. The plan is not considered complete until all excess nutrients from all groups have been accounted for.  To assign the export of a bionutrient group, move the cursor to the gray area of the table and right click to activate the add, delete, undo delete dropdown box.  Right clicking on the add option will load the bio group to the export summary.  The planner can input the quantity and customer information.  The planner can add as many customers as necessary to export the bionutrient group.

Nutrient Risk Analysis

Once the application information has been completed, the final step in completing the plan will be to evaluate potential risks and to provide recommendations for minimizing the risks that have been identified. Each field has a list of risk index factors displayed for both nitrogen and phosphorus.

Nutrient Risk Analysis – Nitrogen
There is no Nitrogen Risk at this time.  This will be coming in the next version.  Oregon heavily relies on phosphorus risk rating to determine nitrogen and phosphorus applications.

Nutrient Risk Analysis - Phosphorus

The planner is prompted to complete the Oregon P-Index on this screen.  The program will use information already collected on previous screens and the information chosen by the user on the P-Index screen to calculate the P-Index.  This will need to be completed for EACH field.  If the planner does not make selections here or anywhere where factors affecting P-Index are entered, the worst case scenario is assumed.  For example if a soil test for phosphorus is not entered, the program assumes 500 ppm.
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There are several additional risk areas that are examined in relation to phosphorus runoff.

Each field has a list of risk index factors displayed.  In the example to the left, the risk index for “P Soil Test 0-12” is listed at “Critical.” This level poses major cause for concern; the planner should use the “Recommendation” button to access the text box which will provide recommendations for dealing with the concern. 
Note: Several categories are at the Very High level which places the entire field into the “Very High” Category.  

Finishing the Plan

The data entry for the plan has now been completed.  The final step is to provide the producer’s name and address. The planner will also be required to enter their name and address.  By clicking on the “Add Owner Info/Producer Summary” the following window will be activated.

Producing the Printed Plan
Once all of the data is input, the calculations have been made; the plan can be printed out. The printout can be of the entire report or any one or more of the individual components of the report.

The reports can be printed to a printer, a file or to a special program such as a PDF writer.

The print out may be 70 – 110 pages in length and may occupy a slow printer for a long time.  
Records
The records tab contains the links to three important items.
· Nutrient Management Plan

· Nutrients

· Pesticides
Nutrient Management Plan
The Nutrient Management Plan will give the planner a printout of the plan report.  This is a way of gaining access to the report without having to navigate to the last page of the program.

Nutrients

The Nutrient option gives the planner access to the history of application of nutrients whether applied in the form a bio-nutrients (manure waste) or commercial fertilizer.

Nutrient Management Plan

The Nutrient Management Plan will give the planner a printout of the plan report.  This is a way of gaining access to the report without having to navigate to the last page of the program.


Pesticides

The Pesticides option should not be used at this time. 

REQUIRED COMPONENTS OF A PRODUCER SUMMARY
The software pack does the majority of the work required to produce a certified nutrient management plan. The planner will need to provide a Producer Summary. The summary will need to be written using the information found in the output from the ONMP software. The following outline is provided as a guide for a planner to follow to insure all of the required information is provided.

FACILITY DESCRIPTION

A general description of the facility that includes:

· Type of facility

· Describe livestock unit(s): Number of animals, weight ranges, and species for which the plan is designed

· Current number of animals

· Future growth of facility

· Type of housing used related to livestock unit

· General description of nearby residential and public use areas

RESOURCE CONCERNS

Summarize all environmentally sensitive issues, how the producer is managing them and specific conservation practices to improve management. Summarize overall nutrient risk ratings (nitrogen leaching and phosphorus runoff) by field in a table, or refer the producer to the Nutrient Risk Analysis in the One Plan NMP printout.

STORAGE AND HANDLING PLAN REQUIREMENTS

Describe all required upgrades or changes in the storage and handling of animal waste on the facility. If additional waste storage needs to be constructed to meet storage requirements provide necessary information on size and compliance date. The compliance date should be in October of the current year.  If October is not realistic, another date should be approved by the Oregon Department of Agriculture.

NUTRIENT MANAGEMENT PLAN REQUIREMENTS

Refer the producer to the Nutrient Management Requirements/Recommendations section in the OnePlan NMP printout.

IRRIGATION MANAGEMENT PLAN REQUIREMENTS

Enter all required upgrades or changes in irrigation management. Example, required changes are:

· If a field is currently a surface water concern, and the plan is written as if the field is a groundwater resource concern (the plan states a sprinkler system will be installed).

· If the producer is over-applying animal waste and the planner will require irrigation set times.

RECOMMENDATIONS

Provide recommendations to upgrade storage and handling, nutrient management, and irrigation management on the facility. Include site-specific conservation practices that would improve nutrient management, irrigation, and waste management practices.
IMPORTANT NOTE: The order in which you select the fields is the order that nutrients will be applied during the nutrient allocation step (one of the final steps of the plan).  On the nutrient allocation page, the first field in the list is loaded with all the nutrients it can handle before the algorithm moves to the next field in the list.  The nutrient loadings can be overridden by the user but its best to select the fields that get the most nutrients first.  In many cases, these fields are the fields closest to the waste storage area.








IMPORTANT NOTE: clicking on the boundary of a feature and pressing the “Delete” key on the keyboard will remove a feature. Once a feature is deleted, the label associated with it will not be removed. There is no way to remove labels once they are on the map.  
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